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| 1. ORDERING GUIDE |

Configure a model number in this format: VL2010DCV1, CBL01

— VL......... VL Series 2 DPM with

screw terminal connectors.

— Display Color

DPM with green LED
DPM with red LED
3. Extended DPM, green LED
4........ Extended DPM, red LED

Note: Extended versions add
rate of change and lineariza-
tion of non-linear inputs. Not
available for thermocouple or
RTD inputs.

— Power

95-240Vac, 95-300 Vdc

1o, 10-48 Vdc, 10-34 Vac
— Setpoint Output

O e, None

i Dual 8A contact relays

2 i, Dual solid state relays
— Analog Output

O e None

T 4-20 mA, 0-10 Vdc
— Digital Interface

O None

Lo RS232

2 e RS485

3 Parallel BCD

Ao, RS485-Modbus
L Input Type

DC Volts

DCV1..ooovieeeeiie, 200.00 mVv

DCV2...iiieeeeeieen 2.0000V

DCVS..ieeeeeeeeie 20.000 V

DCVA....eeeeeeeeiie 200.00V

DCV5* ..o 600.0V

DCV6....ovveeeeeeeeeeeee 300.0V

* Range not UL approved.

DC Amperes

DCAL ..o, 2.0000 mA
DCA2 ... 20.000 mA
DCAS ... 200.00 mA
DCA4 ..., 5.000 A

100 Ohm Platinum RTD’s

P385C.......cc...... -202 to 850°C
P385F.............. -331 to 1562°F
P392C. .............. -202 to 850°C
P392F.............. -331 to 1562°F
Thermocouples

JCaiieieeee -210 to 760°C
N | -347 to 1400°F
KC .o, -244 t0 1372°C
KF o -408 to 2501°F
TC e, -257 t0 400°C
TF e -430 to 752°F
EC . -240 to 1000°C
EF -400 to 1830°F
NC..cooveeeeeen. -245 to 1300°C
NF ., -410 to 2370°F
SCieieeee. -46 to 1768°C
SFeeen -51 to 3214°F
[ { G -45 to 1768°C
RF e -49 to 3213°F

Process Signals
(4-20 mA, 0-10V, etc.)

= 4-20 mA = 0-100.00
Pl................ Custom Scaling

Specify min signal & reading,
max signal & reading.

Strain Gauge, Potentiometer
(4-wire ratio)

......... 0-200 mV = 0-100.00
SGl....ccoeee Custom Scaling

Specify min signal & reading,
max signal & reading. Full-
scale ranges 200 mV to 20V.

RMS Volts

RMV1.................... 200.00 mV
RMV2 ... 2.0000V
RMV3 ... 20.000V
RMV4 ... 200.00V
RMV5* ..., 600.0V
RMV6 ..o 300.0V
RMS Amperes
RMAL................... 2.0000 mA
RMA2 .................... 20.000 mA
RMA3 ... 200.00 mA
RMA4 ... 5.000 A

Load Cells (6-wire ratio)
WML1......... -99,999 to +99,999

Specify min input signal & dis-
played reading, and max input
signal & displayed reading.
Full-scale inputs 20 mV to 500
mV. 10 Vdc excitation.

Options

Extra bright red LED
display.

Blank lens, no button
pads.

Accessories

CBLO1.. RJ11-to-DB9 RS232
cable. Connects me-
ter to PC com port.

CBLO02.. USB-to-DB9 adapter.
For use with CBLO1.
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| 3. PRODUCT INTRODUCTION I

These UL-certified digital panel meters are versatile, cost effective solutions to a wide variety
of monitoring and control applications. Depending on the choice of signal conditioner, they are
easily set up for an accurate display of temperature, pressure, flow, weight, voltage or current,
all in appropriate engineering units and with zero and span adjustment when needed. Setup
can be via front panel pushbuttons or RS232/RS485. Selective security lockout of the front
panel keys protects against accidental changes to meter setup.

High read rates up to 60 per second (50 for 50 Hz operation) are made possible by Concurrent
Slope Conversion (Pat 5,262,780), which integrates the signal over an AC power line cycle for
maximum noise rejection. High read rates provide accurate peak and valley capture, and quick
response for control applications. An adaptive digital filter supplies a time constant for the
encountered signal noise level, yet responds rapidly to changes that exceed a selected
threshold. Self-calibration occurs automatically after every 17th reading.

The standard power supply is a high-efficiency switching unit that operates from AC or DC,
and allows the meters to be powered from worldwide AC without changes. A low-voltage
supply is optional for power from 10-48V batteries or 10-34 Vac. Both supplies provide an
isolated 5, 10 or 24Vdc transducer excitation output .

The meter case conforms to the 1/8 DIN size standard. It is made of high impact, 94V-0 UL-
rated plastic and is watertight to NEMA-4 (IP65) when panel mounted. Mounting is from the
front of the panel and requires less than 110 mm behind the panel. Power and signal wiring is
via removable plugs conforming to UL61010C safety standards. All output options are isolated
from meter and power ground to 250 Vac.

Extended meter versions can linearize nonlinear inputs. Up to 240 data points may be
linearized by a computer program that stores setup parameters in nonvolatiie memory.
Extended meters can also display rate of change. For example, they can display flow based on
changing tank level.

Alarm or setpoint control is made possible by two optional Form C mechanical relays (8A at
250 Vac) or two Form A solid state relays. The setpoints may be latching or non-latching, and
may be configured to be energized above or below the setpoint or in a fail-safe mode. The
relays can operate from the filtered signal to reduce relay chatter or from the unfiltered signal
for fastest response. Snubber circuits and a programmable relay switching time delay extend
relay contact life.

An isolated analog output of 4-20 mA or 0-10V is available with an optional analog output
board. The output is linearized to the display, and can operate from the filtered or unfiltered
signal input. It can be scaled via front panel pushbuttons or RS232/RS485.

Communications options available with Series 2 include RS232 or RS485 1/O, and parallel
BCD output. Serial communications can utilize a custom ASCII protocol or Modbus protocol
compliant with the Modbus Over Serial Line Specification V1.0 (2002) for 2-wire, half-duplex
connection. This includes RTU or ASCIlI modes, up to 247 digital addresses, and up to 32
devices per RS485 line without a repeater.

Computer-aided meter programming using special Setup Software is available for use with the
RS232 and RS485 serial interfaces.



| 4. RECEIVING & UPACKING I

Your meter was carefully tested and inspected prior to shipment. Should the meter be
damaged in shipment, notify the freight carrier immediately. In the event the meter is not
configured as ordered or the unit is inoperable, return it to the place of purchase for repair or
replacement. Please include a detailed description of the problem.

| 5. SAFETY CONSIDERATIONS I

A Warning: Use of this equipment in a manner other than specified may impair the pro-
tection of the device and subject the user to a hazard. Visually inspect the unit for signs of
damage. If the unit is damaged, do not attempt to operate.

Caution:

e This unit must be powered with AC (mains) from 95-240 Vac £10% (90-300 Vdc) with the
high voltage power supply option, or 10-34 Vac +10% (10-48 Vdc) with the low voltage
power supply option. Verify that the proper power option is installed for the power to be
used. This meter has no AC (mains) switch. It will be in operation as soon as power is
connected.

e The 95-240 Vac (95-300 Vdc) mains connector (P1 Pins 1-3) is colored Green to
differentiate it from other input and output connectors. The 10-34 Vac (10-48 Vdc) mains
connector is colored Black.

¢ Do not make signal wiring changes or connections when power is applied to the instrument.
Make signal connections before power is applied. If reconnection is required, disconnect
the AC (mains) power before such wiring is attempted.

e To prevent electrical or fire hazard, do not expose the instrument to excessive moisture.

e Do not operate the instrument in the presence of flammable gases or fumes; such an
environment constitutes a definite safety hazard. This meter is designed to be mounted in a
metal panel.

e Verify the panel cutout dimensions, and mount according to instructions.

Symbols used

A Caution (refer to accompanying documents) J_— Earth (ground) terminal.

A Caution, risk of electric shock. /" Both direct and alternating current.

] Equipment protected throughout by double
insulation or reinforced insulation.

Operating environment:

The meter is Class Il (double insulated) equipment designed for use in Pollution degree 2.



6. CONNECTOR WIRING INFORMATION

CONNECTORS

Connectors for signal and power are U/L
rated screw-clamp terminal blocks that
plug into mating jacks on the printed
circuit board. Communication connectors
are a single RJ11 plug for RS232, dual
RJ11 plugs for RS485, dual RJ45 plugs
for RS485 Modbus, and a 30-pin, mass
termination connector for parallel BCD.

P1 - POWER AND DIGITAL CONTROLS

ACHI (+DCHI)
AC NEUTRAL (DC RET)
EARTH GROUND

CONTROL INPUT 2 (+5V OUT)*
CONTROL INPUT 1*
DIGITAL GROUND

[=l=]=} |=]=}=

DNk Wh =

Caution: Hazardous voltages may be present

on pins 4, 5 & 6.

Note: Control inputs 1 & 2 are menu selectable.

PS - SIGNAL INPUT
DC & PROCESS

Signal Source

-EXCITATION

1| PO or in
+EXCITATION 2l 0 — — — —+
- SIGNAL INPUT 3[ X7 T
+SIGNAL INPUT 4| I +
2 WIRE PROCESS TRANSMITTER
Signal Source
224V EXCITATION 1] Tm
+24V EXCITATION 2| A1) +
_SIGNAL INPUT 3[Trm -
+SIGNAL INPUT 4L 1] !
STRAINGAUGE
10VEXCITATION 1[ m
+10V EXCITATION 2| Jm)
SIGNAL 3ok
+SIGNAL 4| X1

AC (TRUE RMS)

SIGNAL HIGH 1] mm[— 20,200, 600V INPUTS
NC 20 Al

SIGNALLOW 3] mm|— AC NEUTRAL

SIGNAL HIGH 4L L= .2, 2V, CURRENT

INPUTS

6

-10V EXCITATION

+10 V EXCITATION

LOAD CEL

-SENSE

LMETER
J5

-SIGNAL

+SIGNAL

OOk WhN =

+SENSE

E=lEEEE

RTD ( 2-WIRE )

- EXCITATION 1
+ EXCITATION 2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

RTD (

LT

|5E|IEE

3-WIRE )

- EXCITATION 1
+ EXCITATION 2

- SIGNAL INPUT 3

+SIGNAL INPUT 4

w
o |-
T
Il L

RTD (4-WIRE)

- EXCITATION 1
+ EXCITATION 2

- SIGNAL INPUT 3
+SIGNAL INPUT 4

[BH||2E
=

THERMOCOUPLE

1
2
- SIGNAL INPUT 3
+SIGNAL INPUT 4

HE| ||

[ >




P2 - DUAL SETPOINT CONTROLLER

RELAY OUTPUTS (Rev J andearlier)

ALARM 1-N/OCONTACT 1| mm
ALARM1-N/CCONTACT 2| [
ALARM1 - COMMON 3| [N
ALARM2-N/OCONTACT 4] [Im
ALARM2-N/CCONTACT 5| mm
ALARM2 - COMMON 6| [
SOLIDSTATERELAYOUTPUTS
(Rev J and earlier)
ALARM1 1] mm|— +DC(A
ALARM1 2| MO|— +DC(A
ALARM1 3 EH[— -DC(N
ALARM?2 4 mmH— *DC(A
ALARM?2 5| mm— +DC(A
ALARM2 6| [IHi— -DC(N

P3 - SERIAL COMMUNICATIONS

RELAY OUTPUTS (RevK and later)

ALARM1-N/OCONTACT 1] mm
ALARM1 - COMMON 2| I
ALARM1 -N/CCONTACT 3N
ALARM?2-N/OCONTACT 4] Tm
ALARM?2 - COMMON 5| mm
ALARM2- N/CCONTACT 6| [
SOLID STATERELAYOUTPUTS
(Rev K and later)
ALARM1 1] mm}— DCORAC
ALARM1 2| M |— NOTUSED
ALARM1 3D |— DCORAC
ALARM?2 4] mmH DCORAC
ALARM?2 5| mEH— NOTUSED
ALARM?2 6| [Xll— DCORAGC



RS232 INTERFACE

N/C

ISO GND
RX

X

RTS

N/C

RS485 INTERFACE - FULL DUPLEX

6 .
5 =

Computer

yy =

3 -

=

GND
BTX

ATX

ARX

ARX

GND

RS485-MODBUS - FULL DUPLEX

GND

RXDO

RXD1

TXD1

ISO GND (6 mm I
BRX 5 -
ARX 4
ATX 3 -
BTX 2 = .
ISO GND

L=

7 .

6 =
TXDO 5 -
TXD1 4 -

3
RXD1 2 == —
RXDO

L=

TXDO

P4 - ANALOG OUTPUT

4 TO 20 MA OUTPUT
0 TO 10 VDC OUTPUT
ISOLATED GROUND

1
2
3

528

RS485 INTERFACE - HALF DUPLEX

ISO GND

ATX/ARX
BTX/BRX
ISO GND

Py—

6 m—

5- —l_
4 wmm
3 -

2=J

L™=

GND

ATX / ARX
BTX/BRX
GND

RS485-MODBUS - HALF DUPLEX

ISO GND

DO
D1

GND

DO
D1




| 7. MECHANICAL ASSEMBLY I

REMOVING THE REAR PANEL

First remove any connectors. Use one hand to press in the two sides of the rear of the
case, and the other hand to press down the two protruding tab releases at the top of the
rear panel (see figure below). This will unhook the rear panel from the case.

Retaining tab —

with tab release

— Retaining tab

with tab release

Retaining tab l l . Retaining tab
\ | etaining ta
\ / Ining

Rear Panel

REMOVING THE ELECTRONICS

With the rear panel removed, grasp the power supply board to the left and signal condi-

tioner board to the right, and carefully slide the electronic assembly out through the rear of
the case. (see figure below).

INSTALLING NEW OPTION BOARDS

Options boards plug into the main board at the front of the meter. These are plug-and-play
and may installed in the field. They will be recognized by the software, which will provide
access to the menu items associated with that board. If necessary, remove rear panel
knockouts for new boards. Boards plug into connectors as follows:

Option Board Main Board Plug Rear Panel Jack
Power supply P11 J1
Relay board P12 J2
Serial interface board P13 J3
Analog output board P14 J4
Signal conditioner board P15 J5




Note: Corresponding main board and option board connectors have the same number of
electrical lines. When an option board is correctly installed, the top and bottom edges of the
main board and option board are aligned.

REASSEMBLING YOUR METER

Slide the electronics assembly into the case until the display board is seated flush against
the front overlay. Insert the bottom tabs of the rear panel into the case, then carefully align
the board connectors with the openings in the rear panel. If necessary, remove any rear
panel knockouts for new option boards that may have been installed. Ensure that all option
boards are properly aligned with the molded board retaining pins on the inside of the rear
panel. Once the rear panel is in place, reinstall the input/output screw clamp terminal plugs.

PANEL MOUNTING

Ensure that the panel mounted gasket is in place against the back of the bezel. Turn the two
mounting screws counterclockwise until the space between the mounting pawl and the rear
of the gasket is greater than the panel thickness. Insert the meter in the panel cutout. Turn
the mounting screws clockwise until the meter is securely mounted in the panel. Do not
overtighten.

FRONTVIEW REAR VIEW

PI P2 P3 P4 P5

(3.78in)
5mm
(0.197in)£ TOPVIEW SIDEVIEW
r l
- .'
K'\‘Mounting Pawl
102mm
{4.02in) PANELCUTOUT
45 +0.6/-0.0mm
(1.772 +.024/-0.0in)
10mm
v v (0394n) &

92 +0.8/-0.0mm
I (3.622 +.032/-0.0in)

Dimensioned case drawings

10



| 8. FRONT PANEL SETUP KEYS I
" - 05868
STATUS U & (e STATUS.

INDICATOR INDICATCOR
MENU PEAK RESET ALARMS
— > A -
MENUKEY —— | L ALARMKEY
REVERSE MENU
PEAK KEY RESET KEY ( )
(DIGIT SELECT) (VALUE SELECT)

Meter Front Panel

There are four front panel keys, which change function for the Run Mode and Menu Mode,
effectively becoming eight keys. The keys are labeled with alphanumeric captions (MENU,
PEAK, RESET, ALARMS) for the Run Mode and with symbols (M= right arrow,
» right triangle, A up triangle, 4=l left arrow) for the Menu Mode.

FRONT PANEL LOCKOUT

The Menu Mode will not work with most meters as received from the factory, since all menu
items have been disabled in software and a lockout jumper is in place. That jumper needs to
be removed for the Menu Mode to work, and menu items under Loc 1, Loc 2 and Loc 3 then
need to be set to "0" via the front panel for these menu items to be unlocked See Section 9.
The paragraphs below assume that all menu items have been unlocked.

MENU MODE KEY ACTION

In the Menu Mode, pressing a key momentarily advances to the next menu item. Holding
down a key automatically advances through multiple menu items for fast menu navigation.

KEYS IN RUN MODE

MENU Key. Pressing MENU from the Run Mode enters the Menu Mode. Pressing
MENU repeatedly will step the meter through the various menu items (if these have not
been locked out) and then back to the Run Mode.

E PEAK Key. Pressing PEAK normally causes the peak value of the input signal to be
displayed. The peak display then blinks to differentiate it from the normal present value
display. Pressing PEAK again will return the display to the present value. The PEAK key
can also be programmed to display Valley, to display alternating Peak or Valley, or to
Tare the reading to zero. When Peak or Valley is selected, periodic horizontals bars at
the top of the display indicate Peak, and periodic horizontals bars at the bottom indicate
Valley.

RESET Key. Pressing RESET with PEAK resets peak and valley values. Pressing
RESET with ALARMS resets latched alarms. Pressing RESET with MENU performs a
meter reset (same as power on). Meter reset can also be applied via a rear panel
connect or a serial ASCIl command.

11



ALARMS
<l

ALARMS Key. Pressing ALARMS once displays the setpoint for Alarm 1. Pressing it
again displays the setpoint for Alarm 2. Pressing it again returns to the present value.

KEYS IN MENU MODE

MENU
R

RESET

ALARMS

Right Arrow Key (MENU). Pressing l= steps the meter through all menu items that
have been enabled and then back to the Run Mode. With the DC signal conditioner
board and no option boards, available menu items are [Jliat, H2tls. ©d0=c, IS,

SENE, SONNE, ST, [N, W, I If a change has been made to a menu

item, that change is saved to non-volatile memory when the b= key is pressed next,
and is displayed briefly.

Right Triangle Key (Digit Select).

e Pressing P from the InPut menu brings up all meter functions available with the
meter's signal conditioner. For the DC signal conditioner, these are XIS,
and

e Pressing » from the SEtuP, ConfFG, FiLtr, SCALE, OFFSt, Loc 1, Loc 2 or Loc 3
menus items sequentially selects digit positions 1 - 5, as indicated by a flashing digit:
00000M000008

00000M00000mO00008

e Pressing » from the dEC.Pt menu item sequentially selects decimal point positions,
which will flash: [sKefefele| s[eMe[e[e| e[e[cMele| e[e[e[cle| (s[e[s[s[cH Kele[e[ofe|.

Up Triangle Key (Value Select). Pressing A for a flashing item (digit position or
decimal point position) will increment that item. Pressing MENU will save any changes.

Left Arrow Key (Reverse Menu). Pressing «=ll has the same effect as the MENU key,
except that menu items are brought up in reverse order.

12



| 9. ENABLING & LOCKING OUT MENU ITEMS I

For security reasons and ease of meter operation, any and all menu J1

items may be disabled or "locked out" so that they are no longer
directly accessible from the front panel. Each function to be disabled
is set to "1" in menu items Loc 1, Loc 2 or Loc 3, and each function
to be enabled is set to "0." The top menu items Loc 1, Loc 2 and Loc
3 can in turn be locked out by installing an internal hardware jumper.
With the jumper installed, the operator only has access only to
enabled menu items. With the jumper removed, the operator also

has access to menu items Loc 1, Loc 2 and Loc 3.

SETTING HARDWARE LOCKOUT JUMPER

To access the lockout jumper, remove the rear panel per Section 9
and locate jumper “a” in the lower portion of the power supply board

next to the input connectors (see figure at right).

SETTING SOFTWARE LOCKOUTS

When setting up the meter, it may be necessary to
enable specific menu items by setting the corres-
ponding lockout digit to 0. Be sure to reset the lockout
digit to "1" if you do not want the menu item to be
changed by an operator.

Press the =% MENU key until Loc 1, Loc 2 or Loc 3

is displayed, as desired. Note: the hardware lockout
jumper must be removed (see above).

11111

Press P to display the lockout status, consisting of
1’s and 0’s. The left digit will flash. Press P again to
step to the next digit, which will flash.

00000
12345

Press A to set the flashing digit to "0" to enable the
menu item or to "1" to disable. Press MENU to enter.
See the table to the right for list of menu items that
can be enabled or disabled.

13
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Enabled or Disabled
Menu Items

Loc 1

1 - Input type selection.

2 - Meter setup, configuration
& decimal pt.

3 - Filter selection.

4 - Scale or Lo, Hi input.

5 - Offset or Lo, Hi reading

Loc 2

2 - Alarm setup.

3 - Alarm setpoint value
programming.

4 - Analog output scaling.

5 - Serial interface setup.

Loc 3

2 - View peak value
3 - View alarm setpoints

4 - Reset (peak & latched alarms)

5 - Reset (meter reset)




| 10. READING COORDINATES OF 2 POINTS SCALING METHOD I

When the reading coordinates of 2 points* scaling method has been selected under 2illg,
the four menu items below will appear ahead of all other menu items when the MENU or
b= key is first pressed from the run mode.

This scaling method applies a straight line fit between two points, which are determined
from actual transducer signals and the desired corresponding meter readings. A low signal,
such as the output of a pressure transducer at zero pressure, and high signal, such as the
output of the same transducer at a known high pressure, are applied to the meter. The
desired corresponding low and high readings are then entered from the front panel. The
meter then applies straight line fit between the high and low calibration points. This scaling
method has the advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. This method is ideal for
process and load cell meters, which require zero and span adjustment. It is also available
for DC or AC meters. It is not available with thermocouple or RTD meters.

The programming example below is for a process meter used with a 4-20 mA pressure
transducer for 0 to 100 psi. Decimal points are set separately using the dEC.Pt menu.

Press Menu Select
Key

MENU
R

Press Digit Select
Key

Press Value Select
A Key

Apply low signal input
(e.g., transducer output for 0

psi).

oAl Press P to display
reading at low signal input
(e.g., 4.021 mA).

oAl Press A to store low
reading.

Apply high signal input
(e.g., transducer output for
known 100.00 psi source).

PSR Press P to display
reading at high signal input
(e.g., 20.094 mA).

PA[0Re% Press A to store high
reading.

Lo rd BN select B thru B for
Mode to enter desired low Select digit | flashing first digit, § thru [§ for
reading (e.g., 0.00). to flash. other flashing digits.

Hi rd Select K¢ thru g for
Mode to enter desired high Select digit | flashing first digit, § thru [§ for
reading (e.g., 100.00). to flash. other flashing digits.

14




11. DCVOLTS, AMPS, PROCESS, STRAIN

The DC Volts, Amps, Process and Strain meters utilize the DC signal conditioner board, which
needs to be configured via jumpers for the desired voltage or current range. All signal ranges
are factory calibrated with calibration factors stored in EEPROM. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Please see further manual sections for setup of the following:
relay output (15), analog output (16), communication I/O (17), parallel BCD output (18), and
transducer excitation output (19).

Voltage Ranges

FS Input E1 E2 E3

+200.00 mV
+2.0000 V
+20.000 V
+200.00 V
+300V (UL)
+600V (not UL)

WwWwww > >
Q@Q T35 —h —

Current Ranges

FS Input E1 E2 E3
+2.0000 mA A e, g b
+20.000 mA A d, g b
+200.00 mA A ¢ g b
+5.000 A A |abg]| b

1. Use 5 mm (0.2") jumpers for locations designated by a capital letter.
2. Use 2.5 mm (0.1") jumpers for locations designated by a lower case letter.
3. Store spare jumpers on an unused jumper post not associated a capital letter.

SCALE & OFFSET SETUP

For DC voltmeters & ammeters, a scale factor of 1 and an offset of 0 are used for direct
readings in (milli)volts or (milli)amperes. Decimal point selection does not affect the displayed
digits. For example, 0-20V or 0-20 mA signals can both be displayed as 0-20000. A full scale
of 20000 may be displayed as 20.000 mA or 20000 pA. Use with a current shunt will require a
scale factor to be set. For example, for a 500-100 (500A, 100 mV) shunt, divide 5000 (the
desired full scale display with 0.1A resolution) by 10000 (displayed value with 100 mV when
the scale factor is 1.0) for a scale factor of 0.5.

For process & strain meters, scaling is normally set up from the front panel using the » and
A Kkeys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1) Scale and
offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Only menu items
applicable to the selected method will be presented. Please see the Glossary for an
explanation of items marked by an *.

15



KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu
amd Select Key

E Press Digit
Select Key

Press Value Select
A Key

Selection of signal | DC Volts 0.2, 2, 20, 200, 660V FS
nputtype & range
DC Amps 0.2, 20, 200 mA, 5A FS.
Strain gauge & ratio 0.2, 2, 20V FS.
SEtuP 00 00 @ 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display* (£99,999)
scale factor of 1. ¥ 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method*
Scaling method Coordinates of 2 points method*
Reading coordinates of 2 points method*
00 00 B 1= Reset*, 2 = Meter Hold*
Operation of control 1 = Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2: 1 = Hold*, 2 = Peak or Valley Display
True = logic 1 (OV or 1 =Hold*, 2 = Tare*
tied to digital ground) 1 = Peak or Valley Display, 2 = Tare*
False = 0 (5V or open) 1=Tare, 2 = Reset*
B 1=1,2=1, decimal point = XXXXX
1=0, 2=1, decimal point = XXXX.X
1=1,2=0, decimal point = XXX. XX
1 =0, 2 =0, decimal point = XX. XXX
1=1,2=1, decimal point = XXXX.X
1=0, 2=1, decimal point = XXX.XX
1=1,2=0, decimal point = XX.XXX
A =0, 2 =0, decimal point = X.XXX.X
B 1 = Function Reset*, 2 = Display Blank*
B 1 =Hold*, 2 = Display Blank
P 1 = Peak or Valley, 2 = Display Blank*
[ 1=Tare*, 2 = Display Blank*
1 = Valley Display, 2 = Peak Display
B 1=Tare* 2 = Reset Tare to Zero
oth inputs 1 and 2 set to 1 for selections

, |® = Function Reset*
uts 1 and 2 set to 1 for selections
B, & & B, B = Meter Reset*
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
000 0 [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter*. Rate x 1
Extended meter* only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
(0 0 [ Peak Display*. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display*. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak* (1st push), Valley* (2nd push)
Front panel Tare*
000 O [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare* mode
000 O @ Linear input
Nonlinear input scaling Custom curve linearization
Extended meter* only.
00000 @ Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak* & Valley*
Peak & Valley filtering Filtered Peak* & Valley*
00000 B Display batch average every 16 readings
Display filtering Display filtered signal
BN Adaptive filter | Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter*
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average®, 0.08 sec.
play, setpoint, analog Moving average*, 0.15 sec.
output, data output. Moving average®, 0.3 sec.
Moving average*, 0.6 sec.
B Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
B Moving average*, 4.8 sec.
B Moving average*, 9.6 sec.
A Unfiltered
d.dddd d.ddddfidd.dddllddd.ddfidddd.dfiddddd.
Dec. point selection | Decimal point flashes. | [KEBBE| Press A to shift the decimal point.
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IS Press Menu

Press Digit
emd Select Key

Select Key

Press Value Select
A Key

Scaling method “Scale and Offset” if selected under

SCALE PXLls) CNONNN NIElS | Select B thru [§ for flashing first digit, [§] thru g
Scale factor* Xolo ol [oMorelore [iMelelels | for other flashing digits. Select decimal point
digit o fIa location when decimal point is flashing.
PRl ONelelel GNOIeNNE | Select B thru [ for flashing first digit, [§ thru
Offset value* 0.0000M0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [ =@

Scaling method “Coordinates of 2 points” if sel

ected under

PXL]s) CNONNN NeINEls | Select B thru [§ for flashing first digit, [§] thru g
Low signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLLe CNONNN BNENls | Select & thru [§ for flashing first digit, [§] thru [§
Desired reading at | (HoQefels ONeJeJofe! for other flashing digits. Decimal point is set

Lo In. Select digit to flash. WA EC. P

Hi In PXLLs) CNONNN BNIls | Select B thru [§ for flashing first digit, [§] thru g

High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

BN CNOY OEEIIY | Select B thru ] for flashing first digit, § thru §

Desired reading at | [iXeJolols] OXelelele) for other flashing digits. Decimal point is set

Hi In. Select digit to flash GYdEC. P

Scaling method “Reading coordinates of 2 points” if selected under

i
!

0.02
Apply a low reference
signal to the meter.

0 In
Low signal input.

Press A to store the low signal input in the
meter.

20.094
Apply a high reference
signal to the meter.

i In
igh signal input.

N T

Press A to store the high signal input in the
meter.

Lo rd 0.00000.00000.0000@g0.0000

Desired reading at | SXJeY SXEOI® Select ¥ thru [§ for flashing first digit, [§] thru g

Lo In. Select digit to flash. for other flashing digits. Decimal point is set
’ by EEIE.

0.00000.0000[§0.0000§§6.7500

DESIEREEET TN 0000j0.0000 Select K thru g for flashing first digit, ] thru

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

SRdEC Pl

1
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Option board dependent menu items

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section15.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 16.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/O board is detected. If so, see Section 17.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [l Decimal point is set by f[=ea.

19



| 12. LOAD CELL & MICROVOLT INPUTS I

The Load Cell and Microvolt meters utilize the load cell signal conditioner board, which offers
sensitivity to £20 mV full scale and 4 or 6-wire load cell connection. This board needs to be
configured via jumpers for the desired voltage range. All signal ranges are factory calibrated
with calibration factors stored in EEPROM. The meter software recognizes the board and will
bring up the appropriate menu items for it; however, it does not recognize the jumper settings.
Please see further manual sections for setup of the following features: relay output (15),
analog output (16), communication I/O (17), parallel BCD output (18), and transducer
excitation output (19).

RANGE SELECTION VIA JUMPERS

. : b c
Ranges & Display with - -
Scale Factor =1 | | i
Input Jumpers Ziﬂ:);(;ale a o d
H B B
120 mV e +20000
50mvV| a 50000 e ~
100 mV b +10000 il el
1250 mV c +25000 .
1500 mV d +50000

Notes 1. See Section 19 to select 10V excitation.
2. Jumpers are 2.5 mm (0.1 in).

SCALE & OFFSET SETUP

For DC microvolt meters, a scale factor of 1 and an offset of 0 are used for direct readings in
microvolts or millivolts. Decimal point selection does not affect the displayed digits. For
example, 20 mV can be displayed as 20.000 mV or 20000 uyV. The decimal point is set
separately.

For load cell applications, scaling is normally set up from the front panel using the » and A
keys, but can also be set up via RS232/485 using special PC-compatible setup software
(available at no charge). The meter allows three scaling methods to be selected: 1). Manual
scale and offset*, 2) Coordinates of 2 points*, and 3) Reading coordinates of 2 points*. Please
see the Glossary for an explanation of each method. Please see the Glossary for an
explanation of each method marked by an *.
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KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
100.0)f 250.08 500.0

Selection of signal
input type & range

Strain or ratiometric

20, 50, 100, 250, 500 mV FS voltage

DC millivolts 20, 50, 100, 250, 500 mV FS voltage
SEtuP 00_00 @ 4-1/2 digit meter, counts by 1
Meter Setup Display type 5-digit remote display* (+99,999)
4-1/2 digit meter, counts by 10
3-1/2 digit meter
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method*
Scaling method Coordinates of 2 points method*
Reading coordinates of 2 points method*
00 00 [ 1=Reset*, 2 = Meter Hold*
Operation of control 1 = Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2: 1 = Hold*, 2 = Peak or Valley Display
True = logic 1 (OV or 1 = Hold*, 2 = Tare*
tied to digital ground) 1 = Peak or Valley Display, 2 = Tare*
False = 0 (5V or open) 1 =Tare*, 2 = Reset"
@ 1=1,2=1, decimal point = XXXXX
1=0, 2=1, decimal point = XXXX.X
1=1,2=0, decimal point = XXX.XX
1=0, 2 =0, decimal point = XX.XXX
1=1, 2=1, decimal point = XXXX.X
1=0, 2=1, decimal point = XXX.XX
1=1,2=0, decimal point = XX. XXX
1=0, 2=0, decimal point = X. XXX.X
B 1 = Function Reset*, 2 = Display Blank*
& 1 =Hold*, 2 = Display Blank
A 1 =Peak or Valley, 2 = Display Blank*
B 1 =Tare*, 2 = Display Blank*
1 = Valley Display, 2 = Peak Display
B 1=Tare* 2 = Reset Tare to Zero
Both inputs 1 and 2 set to 1 for selections
B, B I @ = Function Reset*
Both inputs 1 and 2 set to 1 for selections
B0 EEE E B B =Meter Reset*
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
000 0O [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter*. Rate x 1
Extended meter* only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
000 0 @ Peak Display*. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display*. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak* (1st push), Valley* (2nd push)
Front panel Tare*
000 O [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare* mode
000 O @ Linear input
Nonlinear input scaling Custom curve linearization
Extended meter* only.
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak* & Valley*
Peak & Valley filtering Filtered Peak* & Valley*
00000 B Display batch average every 16 readings
Display filtering Display filtered signal
BN Adaptive filter | Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter*
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average®, 0.08 sec.
play, setpoint, analog Moving average*, 0.15 sec.
output, data output. Moving average®, 0.3 sec.
Moving average*, 0.6 sec.
B Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
B Moving average*, 4.8 sec.
B Moving average*, 9.6 sec.
A Unfiltered
d.dddd d.ddddfidd.dddllddd.ddfidddd.dfiddddd.
Dec. point selection | Decimal point flashes. | Kllslels
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IS Press Menu

Press Digit
emd Select Key

Select Key

Press Value Select
A Key

Scaling method “Scale and Offset” if selected under

SCALE PXLls) CNONNN NIElS | Select B thru [§ for flashing first digit, [§] thru g
Scale factor* Xolo ol [oMorelore [iMelelels | for other flashing digits. Select decimal point
digit o fIa location when decimal point is flashing.
PRl ONelelel GNOIeNNE | Select B thru [ for flashing first digit, [§ thru
Offset value* 0.0000M0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [ =@

Scaling method “Coordinates of 2 points” if sel

ected under

PXL]s) CNONNN NeINEls | Select B thru [§ for flashing first digit, [§] thru g
Low signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLLe CNONNN BNENls | Select & thru [§ for flashing first digit, [§] thru [§
Desired reading at | (HoQefels ONeJeJofe! for other flashing digits. Decimal point is set

Lo In. Select digit to flash. WA EC. P

Hi In PXLLs) CNONNN BNIls | Select B thru [§ for flashing first digit, [§] thru g

High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

BN CNOY OEEIIY | Select B thru ] for flashing first digit, § thru §

Desired reading at | [iXeJolols] OXelelele) for other flashing digits. Decimal point is set

Hi In. Select digit to flash GYdEC. P

Scaling method “Reading coordinates of 2 points” if selected under

i
!

0.02
Apply a low reference
signal to the meter.

0 In
Low signal input.

Press A to store the low signal input in the
meter.

20.094
Apply a high reference
signal to the meter.

i In
igh signal input.

N T

Press A to store the high signal input in the
meter.

Lo rd 0.00000.00000.0000@g0.0000

Desired reading at | SXJeY SXEOI® Select ¥ thru [§ for flashing first digit, [§] thru g

Lo In. Select digit to flash. for other flashing digits. Decimal point is set
’ by EEIE.

0.00000.0000[§0.0000§§6.7500

DESIEREEET TN 0000j0.0000 Select K thru g for flashing first digit, ] thru

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

SRdEC Pl
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Option board dependent menu items

Menu items related to alarm setup These iwill only appear if a relay board is detected. If so,
please see Section15.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 16.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/O board is detected. If so, see Section 17.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.
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| 13. AC RMS VOLTS & AMPS |

The AC RMS Voltmeters and Ammeters utilize an AC signal conditioner board with precision
circuitry to compute the root-mean-square of complex waveforms from 10 Hz to 10 kHz.
Spikes up to 2.4 times the maximum of each range are accurately measured. The input is AC
coupled to read only the AC component, such as ripple on a power supply. The board needs to
be configured via jumpers for the desired voltage or current range. All signal ranges are factory
calibrated with calibration factors stored in EEPROM. The meter software recognizes the
board and will bring up the appropriate menu items for it; however, it does not recognize the
jumper settings which set the ranges. These need to be entered manually. Please see further
manual sections for setup of the following features: relay output (15), analog output (16),
communication I/O (17), parallel BCD output (18), and transducer excitation output (19).

Voltage Ranges

Full Scale Input | Counts | Jumpers B BaB H:l
200 mV 20000 g, k h A il
2V 20000 9] HoEDLHE ’ @
20V 20000 h, k f *
200V 20000 h, j H BcHB
300V (UL) 3000 f,]
600V (not UL 6000 f,]

(not UL ) HeEdH mkE
Current Ranges :

Hi AmH

Full Scale Input | Counts | Jumpers
2 mA 20000 e fk
20 mA 20000 d, f, k RANGE SELECTION VIA JUMPERS
200 mA 20000 c, f, Kk 1. Use 2.5 mm (0.1") jumpers.
5A 5000 a, b, f,m 2. Store spare jumpers on unused jumper post.

METER SCALING

Refer to the above tables for the full scale counts (or displayed digits) produced by the
available full scale input ranges with a scale factor of 1 and an offset of 0. The decimal point
can be set for direct readout in (milli)volts or (milli)amperes. Decimal point selection does not
affect the counts. For example, a 20V input may be displayed as 20.000V or 20000 mV.

The 5A range, designed for use with a 5A current transformer (CT), is scaled to produce 5000
counts with a scale factor of 1 and an offset of 0. Use with a specific CT will require the scale
factor to be set. For example, for an 800A input, 5A output CT, set a scale factor of 1.6. This is
the desired 8000 count display at 5A divided by the default 5000 count display at 5A. Then set
the decimal point to display to 800.0 at 5A.

All scaling methods applicable to DC, process, strain and load cell meters are available with
AC RMS meters. Readings below 10 counts are displayed as 0.
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KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
20.0Uf200.0Ul660.0U

Selection of signal
input type & range

Strain or ratiometric

0.2, 2, 20, 200, 660V FS

DC millivolts 0.2, 20, 200 mA, 5A FS.
SEtuP 00 00 @ 4-1/2 digits (+20,000)
Meter Setup Display selection with Remote display* (£99,999)
scale factor of 1 4-1/2 digits, counts by 10 (£20,000)
3-1/2 digits (+2,000)
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method*
Scaling method Coordinates of 2 points method*
Reading coordinates of 2 points method*
00 00 [ 1=Reset*, 2 = Meter Hold*
Operation of control 1 = Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2. 1 = Hold*, 2 = Peak or Valley Display
True = logic 1 (OV or 1 =Hold*, 2 = Tare*
tied to digital ground) 1 = Peak or Valley Display, 2 = Tare*
False = 0 (5V or open) 1=Tare", 2= Reset"
B 1=1,2=1, decimal point = XXXXX
1=0, 2=1, decimal point = XXXX.X
1=1,2=0, decimal point = XXX.XX
1=0, 2 =0, decimal point = XX.XXX
1=1, 2=1, decimal point = XXXX.X
1=0, 2=1, decimal point = XXX.XX
1=1,2=0, decimal point = XX. XXX
1=0, 2=0, decimal point = X. XXX.X
B 1 = Function Reset*, 2 = Display Blank*
& 1 =Hold*, 2 = Display Blank
A 1 =Peak or Valley, 2 = Display Blank*
B 1 =Tare*, 2 = Display Blank*
1 = Valley Display, 2 = Peak Display
B 1=Tare* 2 = Reset Tare to Zero
Both inputs 1 and 2 set to 1 for selections
B, B I @ = Function Reset*
Both inputs 1 and 2 set to 1 for selections
B0 EEE E B B =Meter Reset*
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy 9 Key
000 0O [ Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter*. Rate x 1
Extended meter* only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
00 0 [ Peak Display*. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display*. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak* (1st push), Valley* (2nd push)
Front panel Tare*
000 O [ Meter comes up in normal run mode.
Auto-tare Meter comes up in auto-tare* mode
000 O @ Linear input
Nonlinear input scaling Custom curve linearization
Extended meter* only.
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak* & Valley*
Peak & Valley filtering Filtered Peak* & Valley*
00000 [l Display batch average every readings
Display filtering Display filtered signal
M) Adaptive filter |[ Low adaptive filter threshold level
threshold High adaptive filter threshold level
00000 B Autofilter*
Input signal filtering. Batch average, 16 readings
Can be applied to dis- Moving average®, 0.08 sec.
play, setpoint, analog Moving average*, 0.15 sec.
output, data output. Moving average®, 0.3 sec.
Moving average*, 0.6 sec.
B Moving average*, 1.2 sec.
Moving average*, 2.4 sec.
B Moving average*, 4.8 sec.
B Moving average*, 9.6 sec.
A Unfiltered
| L. cddd d.ddddfldd.dddfiddd.ddffdddd. dfiddddd.
Dec. point selection | Decimal point flashes. | [EFHEER
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IS Press Menu

Press Digit
amd Select Key

Select Key

Press Value Select
A Key

Scaling method “Scale and Offset” if selected under

SCALE PXLls) CNONNN NIElS | Select B thru [§ for flashing first digit, [§] thru g
Scale factor* Xolo ol [oMorelore [iMelelels | for other flashing digits. Select decimal point
digit o fIa location when decimal point is flashing.
PRl ONelelel GNOIeNNE | Select B thru [ for flashing first digit, [§ thru
Offset value* 0.0000M0.0000 for other flashing digits. Decimal point
Select digit to flash. location is selected by [ =@

Scaling method “Coordinates of 2 points” if sel

ected under

PXL]s) CNONNN NeINEls | Select B thru [§ for flashing first digit, [§] thru g
Low signal input. 0.0000[0.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

Lo rd PXLLe CNONNN BNENls | Select & thru [§ for flashing first digit, [§] thru [§
Desired reading at | (Eoefels ONeJeJofe! for other flashing digits. Decimal point is set

Lo In. Select digit to flash. WA EC. P

Hi In PXLLs) CNONNN BNIls | Select B thru [§ for flashing first digit, [§] thru g

High signal input. 0.00000.0000 for other flashing digits. Decimal point is set
Select digit to flash. by input range chosen.

BN CNOY OEEIIY | Select B thru ] for flashing first digit, § thru §

Desired reading at | [tXeJolols] (Xelelele) for other flashing digits. Decimal point is set

HiIn. Select digit to flash GYdEC. P

Scaling method “Reading coordinates of 2 points” if selected under

i
!

0.02
Apply a low reference
signal to the meter.

olIn
Low signal input.

Press A to store the low signal input in the
meter.

20.094
Apply a high reference
signal to the meter.

iIn
igh signal input.

N T

Press A to store the high signal input in the
meter.

Lo rd 0.00000.00000.0000@g0.0000

Desired reading at | SXJeY] SXIO® Select ¥ thru [§ for flashing first digit, [§] thru g

Lo In. Select digit to flash. for other flashing digits. Decimal point is set
’ by EEIE.

0.000080.0000[0.0000§§6.7500

BESTEREEET TN 00000.0000 Select K thru g for flashing first digit, ] thru

Hi In. Select digit to flash. for other flashing digits. Decimal point is set

SRdEC Pl
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Option board dependent menu items

Menu items related to alarm setup These iwill only appear if a relay board is detected. If so,
please see Section15.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 16.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 I/0O board is detected. If so, see Section 17.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

*  See Glossary for explanation of item.

** Scaling method 2, “Reading Coordinates of 2 Points Scaling Method,” will appear before all
other Menu items, including [l Decimal point is set by f[=ea.
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| 14. TEMPERATURE: THERMOCOUPLE & RTD I

Thermocouple and RTD meters utilize the temperature signal conditioner board, which can be
configured via jumpers for 7 thermocouple types (J, K, T, E, N, S, R) and 2 Pt 100 RTD types
(DIN with temperature coefficient of 0.00385 ohms/ohm/°C or ANSI with temperature coeffi-
cient of 0.003925 ohms/ohm/°C). All signal ranges are factory calibrated. The meter software
recognizes the board and will bring up the appropriate menu items for it; however, it does not
recognize the jumper settings. Display in °C or °F and resolution of 1°, 0.1° or 0.01° are user
programmable. High resolution should only be used for relative readings, not absolute
readings. Although available, 0.01° resolution is not recommended for thermocouples.

The addition of a relay output board turns the meter from a temperature indicator into a
temperature controller. Please see further manual sections for setup of the following features:
relay output (Section 15), analog output (16), communication 1/O (17), parallel BCD output
(18), and transducer excitation output (19).

SIGNAL CONDITIONER BOARD SETUP VIA JUMPERS

Thermocouples

Type Jumpers a
J,K,E,N e

T,R,S f

Open Indication Jumpers

Upscale C

Downscale d

Pt 100 RTD connection e
Connection Jumpers

2- or 4-wire b, e

3-wire a, e

1. Use 2.5 mm (0.1") jumpers.
2. Store spare jumpers on an unused jumper post.

SCALE & OFFSET SETUP

Scale is available for RTDs (but not thermocouples) and is normally set to 1.0000. Scale can
be used as an adjustment when actual resistance is other than 100 ohms, as stated on the
RTD calibration sheet. To calculate scale, divide 100 by the stated resistance at 0°C. For
example, for a 99.04 ohm RTD, scale should be set to 100 / 99.04 = 1.0097.

Offset is available for thermocouples and RTDs, and is normally set to 0000.0. If °C is
selected, entering an offset of 0273.2 will change the display to Kelvin. If °F is selected,
entering 0459.7 will change the display to Rankine.
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RTD CONNECTION

With the appropriate a, b, e jumper positions, Excitation | 1 —
the RTD meter allows 2, 3 or 4-wire RTD +Excitation | 2 .—‘

hookup to the J5 connector, as illustrated. -Signal input | 3 I:I
The meter applies an excitation current of 0.2 +Signalinput | 4 '

mA, which it monitors to make ratiometric
corrections for excitation supply variations.

In 2-wire hookup, the meter senses the
voltage drop across the 100 ohm RTD and

both lead wires. The effect of the lead wires -Excrtat!can 4 i B

can be measured and subtracted by shorting ;Excrﬁt'ﬂ i |:|

out the RTD during meter setup. The short ;S;gzgl :Egut 4 ]

should be as close as possible to the RTD.

Ambient temperature changes will still cause

some error in the readings -- the higher the

lead resistance, the greater the error. dwire P100 RTD

2-wire lead resistance compensation -Excitation | 1 —
+Excitation | 2

Under the menu selection, the two Signal input | 3 | |

RTD leads are shorted out, the P key is +5ignalinput | 4

pushed, a value proportional to lead resist-
ance is displayed, and that value is auto-

2-wire Pt100 RTD

J-wire Pt100 RTD

matically stored in the meter. After this step, DIN or ANSI and °F or °C need to be selected.

In 3-wire hookup, the meter automatically compensates for lead resistance by measuring the
voltage drop in one current carrying lead and assuming that the other current carrying lead is
the same.

In 4-wire hookup, no compensation for lead resistance is necessary. The step of shorting out
the RTD during meter setup is not necessary with either 3 or 4-wire hookup.

31



KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

Press Menu E Press Digit Al Press Value Select
amd Select Key Select Key A ICY
Vidall IR Type J, °F or °C

Selection of signal | Thermocouple
input type & range

i
)
T
~
[
@)

Type K, °F or °C
Type N, °F or °C
Type E, °F or °C
Type T, °F or °C
Type S, °F or °C
Type R, °F or °C
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Pt 100 ohm RTD
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4-wire DIN , °F or °C
4-wire ANSI, °F or °C
3-wire DIN, °F or °C
3-wire ANSI, °F or °C
2-wire DIN, °F or °C
2-wire ANSI, °F or °C
Slilelgl 2-wire lead resistance compensa-
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the meter, short the two leads adjacent to the
RTD, and press P> to automatically store a
value proportional to lead resistance. After
that, go back to select

| 2d °F | 2d °C | 2A °F Ky 2A°C ]

SEtuP 00 00 [ 0.1 degree resolution
Meter Setup Display selection with Remote display* (£99,999)
scale factor of 1. 0.01 degree resolution
1 degree resolution
00 00 [ Noise minimized for 60 Hz
Power line frequency Noise minimized for 50 Hz
00 00 [ Scale and offset method* for RTDs,

Scaling method offset only for thermocouples

00 00 1 = Reset*, 2 = Meter Hold*
Operation of control 1 = Function Reset*, 2 = Peak*or Valley*
inputs 1 & 2: 1 = Hold*, 2 = Peak or Valley Display

= Hold*, 2 = Tare*
Peak or Valley Display, 2 = Tare*
Tare*, 2 = Reset*

True = logic 1 (OV or
tied to digital ground)
False = 0 (5V or open)

[l I [@¥] [ [ (=1

1
1
1
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=] Press Menu E Press Digit Al Press Value Select
md Select Key Select Key Yy 9 Key
SEtuP 00 00 @ 1=1,2=1, decimal point = XXXXX
Meter Setup Operation of control 1=0, 2 =1, decimal point = XXXX.X
(continued) inputs 1 & 2: 1=1,2 =0, decimal point = XXX. XX
(continued) 1=0, 2 =0, decimal point = XX. XXX
1=1,2=1, decimal point = XXXX.X
1=0, 2=1, decimal point = XXX. XX
1=1,2=0, decimal point = XX. XXX
1=0, 2 =0, decimal point = X.XXX.X
B 1 = Function Reset*, 2 = Display Blank*
B 1 =Hold*, 2 = Display Blank
A 1=Peakor Valley, 2 = Display Blank*
[ 1 =Tare*, 2 = Display Blank*
1= VaIIey Display, 2 = Peak Display
B 1=Tare*, 2 = Reset Tare to Zero
Both inputs 1 and 2 set to 1 for selections
B, A A @ = Function Reset*
Both inputs 1 and 2 set to 1 for selections
B0 E S E 8 B B = Meter Reset*
000 0 B Not rate of change
Meter Configuration | Operation as a rate of Rate x 0.1
change meter*. Rate x 1
Extended meter* only. Rate x 10
Rate x 100
Rate x 1000
B Rate x 10000
00 0 [ Peak Display*. Also selects “Peak” in
Operation of front “Peak or Valley” at connector above.
panel PEAK button Valley Display*. Also selects “Valley” in
and rear connector for “Peak or Valley” at connector above.
Peak or Valley Display Peak™ (1st push), Valley* (2nd push)
Front panel Tare*
00000 B Unfiltered output
Filtering Alarm filtering Filtered output
00000 [ Unfiltered Peak* & Valley*
Peak & Valley filtering Filtered Peak* & Valley*
00000 [l Display batch average every 16 readings
Display filtering Display filtered signal
Adaptive filter |[] Low adaptive filter threshold level
threshold High adaptive filter threshold level
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=] Press Menu E Press Digit Press Value Select
amd Sclect Key Select Key Key

00000

Filtering Input signal filtering.
(continued) Can be applied to dis-
play, setpoint, analog
output, data output.

Autofilter*

Batch average, 16 readings
Moving average*, 0.08 sec.
Moving average*, 0.15 sec.
Moving average®*, 0.3 sec.
Moving average*, 0.6 sec.
Moving average®*, 1.2 sec.
Moving average®, 2.4 sec.
Moving average*, 4.8 sec.
Moving average*, 9.6 sec.
Unfiltered

> 1O JOO [N JOTD T I [ O

dEc.P d.ddd d.dddd

Dec. point selection | Decimal point flashes. | [FEEEEE

(o}

SCALE
Scale factor*

o
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o
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o
(@]

Select K¢ thru g for flashing first digit, §] thru
for other flashing digits. Select decimal point
location when decimal point is flashing.
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OFFst
Offset value*

. Select K thru g for flashing first digit, §] thru
0000 for other flashing digits. Use offset for display
Select digit to flash. in Rankine or Kelvin. Decimal point location
J is selected by [s]=eH 1.

Sfo
o100
oo
o110
(@] [®)
SIS
o
o
o
(@)
[«)
o
o
o
(@)

Option board dependent menu items

ALSEt JdEU1HIdEU2H|dEU1bJdEU2b)

Menu items related to alarm setup These will only appear if a relay board is detected. If so,
please see Section15.

Menu items related to analog output setup. These will only appear if an analog output
board is detected. If so, see Section 16.

Menu items related to serial communications. These will only appear if an RS232 or
RS485 1/O board is detected. If so, see Section 17.

Menu lockout items

Menu items used to enable or lock out (hide) other menu items. Loc menu items may in turn
be locked out by a hardware jumper. Please see Section 9.

* See Glossary for explanation of item.
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| 15. DUAL RELAY OUTPUT OPTION I

An optional dual contact relay board or dual solid state relay board may be may be installed in
the meter main board at plug position P12, adjacent to the power supply board. Once installed,
the relay board is recognized by the software, which will bring up the appropriate menu items.
These menu items will not be brought up if a relay board is not installed. Both relay boards
offer a choice of operating modes: latched* or non-latched*, hysteresis band*, deviation band*,
actuation based on the filtered or unfiltered signal, and selectable number of readings in alarm
zone to cause an alarm. Please see the Glossary at the end of this manual for an explanation
of terms marked by an *.

KEYSTROKES FOR VIEWING & CHANGING SETPOINTS

It is not necessary to enter the setup menu to view or change setpoints. This allows the meter
to continue conversions and provide outputs when setpoints are displayed. After pressing ¢l
(Alarms), you have 30 seconds to enter a change, or the meter reverts to normal display.

Press Alarms
el KEY

E Press Digit
Select Key

Press Value Select
A Key

300.24

Press 4=l (Alarms) to
display Alarm 1 setpoint.

200.00

Current setpoint 1 value blinks,
and Alarm 1 LED indicator
lights. Press P> to select a digit,
which will blink.

295.00

To change setpoint 1 value,
press A to change selected
blinking digits.

395.00
Press 4=l (Alarms) to
display Alarm 2 setpoint.

395.00

Current setpoint 2 value blinks,
and Alarm 2 LED indicator
lights. Press P> to select a digit,
which will blink.

305.00

To change setpoint 2 value,
press A to change selected
blinking digits.

W% Press el (Alarms) again. The meter will reset and display the current reading.

KEYSTROKES FOR SETUP
If the MENU B= key does not work, see Section 9 “Enabling & Locking Out Menu Items.”

=0 Press Menu E Press Digit Press Value Select

mad Select Key Select Key A &Y

00000 [ Relay 10on Relay 2 on

Alarm Setup. Relay state when Relay 1 off Relay 2 on

Press lm yntil alarm is active. Relay 1 on Relay 2 off

ALSEt is displayed Relay 1 off Relay 2 off

(with relay board). 00000 @ Alarm 1 auto reset Alarm 2 auto reset
Alarm latching* or non- Alarm 1 latching Alarm 2 auto reset
latching* (auto reset). Alarm 1 auto reset  Alarm 2 latching

Alarm 1 latching Alarm 2 latching

w
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=] Press Menu E Press Digit Press Value Select
md Select Key Select Key Yy ¥ Key
00000 [ AL1 active high AL2 active high
Alarm Setup. Alarm operates at and AL1 active low AL2 active high
(continued) above setpoint (active AL1 disabled AL2 active high
high) or at and below AL1 active high AL2 active low
setpoint (active low). AL1 active low AL2 active low
AL1 disabled AL2 active low
B AL1 active high AL2 disabled
AL1 active low AL2 disabled
@ AL1 disabled AL2 disabled
00000 @ AL1 band deviation AL2 band deviation
Hysteresis mode* or AL1 hysteresis AL2 band deviation
band deviation mode* AL1 band deviation AL2 hysteresis
AL1 hysteresis AL2 hysteresis
No deviation or hysteresis in menu.
@ After 1 reading
Number of readings in After 2 readings
alarm zone to cause After 4 readings
an alarm. After 8 readings
After 16 readings
After 32 readings
[ After 64 readings
After 128 readings
dEU1H Select [l thru [§ for flashing first digit, [§ thru g
Alarm 1 hysteresis* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of hysteresis band).
Select B thru [§ for flashing first digit, [§ thru g
Alarm 2 hysteresis* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of hysteresis band).
Select B thru [§ for flashing first digit, [§ thru g
Alarm 1 deviation* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value
entered (half of deviation band).
Select X thru g for flashing first digit, §] thru
Alarm 2 deviation* for other flashing digits. Alarms will operate
Select digit to flash. above and below the setpoint by the value

entered (half of deviation band).

* See Glossary for explanation of item.
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| 16. ANALOG OUTPUT OPTION I

An optional analog board may be may be connected to the meter main board at plug position
P14, adjacent to the signal conditioner board. Once installed, the analog output board is
recognized by the meter, which will bring up the appropriate menu items. These items will not
be brought up if an analog output board is not installed.

Both current (0-20 mA or 4-20 mA) and voltage (0-10 Vdc) | s1o20ma0UTPUT 175
analog outputs are selectable at connector P4. One of three | 0 To10vDCOUTPUT 2| [1m
analog output spans (0-20 mA, 4-20 mA or 0-10 Vdc) may be ISOLATED GROUND 3| Im
selected in software for scaling. The low analog output (0 mA,
4 mA or OV) may be set to correspond to any low displayed
reading An Lo. The corresponding high analog output (20 mA
or 10V) may be set to correspond to any high displayed reading An Hi. The meter will then
apply a straight line fit between these two end points, thereby providing an analog output
scaled to the displayed reading for the selected span.

P4 - ANALOG OUTPUT

Although both current and voltage outputs are available at connector P4, only one is calibrated
to specifications. If the calibrated output is 0-10V, the non-calibrated output is 0-20 mA. If the
calibrated output is 0-20 mA, the non-calibrated output is 0-10V. Both of these non-calibrated
outputs are accurate to 1% typical, 2% max. If the calibrated output is 4-20 mA, the non-
calibrated output is 2.5-10V.

KEYSTROKES FOR SETUP
If the MENU I key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

IS Press Menu

Press Digit Select Press Value Select
amd Sclect Key

Key Key

[ 0-20 mA current output
Analog Output Setup. | Selection of calibrated output. 0-10V voltage output
Press Im until AnSEt 4-20 mA current output
:nglli)‘;liﬁgtf{%%lg:gi 00 | [ Analog output unfiltered
Analog output filtering. Analog output filtered

Low displayed value
for 0 mA, 4 mA or OV
output

Select B thru [g for flashing first
digit, [§ thru [§] for other flashing

digits. Decimal point location is
fixed by selection.

High displayed value
for 20 mA or 10V out-
put

Select digit to flash.
0.0000
Select digit to flash.

Select X thru g for flashing first
digit, [§ thru [§] for other flashing

digits. Decimal point location is
fixed by selection.
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| 17. SERIAL COMMUNICATION OPTIONS I

An optional serial communications board (RS232, RS485 or RS485-Modbus) may be con-
nected to the meter main board at plug position P13 (middle position). Once installed, this
board is recognized by the meter, which will bring up the appropriate serial communication
menu items. These items will not be brought up if a communication board is not installed.

The RS485 and RS485-Modbus boards are electrically equivalent, but have a slightly different
physical layout. The RS485 version uses two RJ11 connectors, while the RS485-Modbus
version uses two RJ45 connectors for compliance with the Modbus standard. Both boards
feature dual connectors, which are wired in parallel to allow daisy chaining of addressable
meters with no need for a communications hub. All three boards are compatible with the same
serial three communication protocols, which are selectable under meter setup: Custom ASCII*,
Modbus* RTU, and Modbus* ASCII. Digital addressing of multiple meters on the same serial
communication line requires RS485 or RS485-Modbus boards.

BOARD SETUP VIA JUMPERS

RS232 Board

g - Normal operation.

h - Slave display operation to RS232 output of
another meter.

J - Pull-up resistor on RTS line.

E—ETECE

Note: The board is shipped standard with jumpers RS5-232

g and j installed.

RS485 and RS485-Modbus Boards mam
Full Duplex Operation mhm Ecudm

b & e - These bias jumpers should be installed on 1 men ufm
(and only 1) meter.

a & d - installed on last meter in line with long cable
runs.

R5-485

Half Duplex Operation
ndmce =
b & e - bias jumpers installed on 1 board. e

c & f - installed for half duplex operation. " ufm
a - installed on last meter in line with long cable runs. mam mbhnm
Note: The boards are shipped standard with no Modbus

jumpers installed.
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KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

=] Press Menu E Press Digit Select Press Value Select
md Select Key Key Y 9 Key
| 000 @ Send unfiltered signal
Fixed Parameters: | Output filtering Send filtered signal
No parity —000) § 300 baud
8 data bits
1 stop bit Baud rate 600 baud
1200 baud
2400 baud
4800 baud
9600 baud
B 19200 baud
| 000 60 Hz 50 Hz
Output update rate @ Line frequency Line frequency
0.28 sec 0.34 sec
0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
4.5 sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
B 36.6 sec 43.5 sec
[ 72.5sec 97 sec
0000 @ No line feed after carriage return
Serial Setup 2 Line feed Line feed after carriage return
0000 @ No alarm data
Alarm data with readings Alarm data with reading
0000 [ Continuous data output
Control of data output Data output on ASCII command only
0000 Select [ thru |g for addresses 1 thru 15.
Meter address with Custom | Select {8} thru [g (with decimal point) for
ASCII protocol* addresses 16 thru 31.
00000 @ Full duplex
Serial Setup 3 Half or full duplex Half duplex
00000 @ Standard continuous mode
Special start & stop char. Special start & stop characters
00000 @ Normal RTS
RTS mode Single transmission
00000 E Only at end of all items
1

Termination characters

At end of each item
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=] Press Menu E Press Digit Select Press Value Select
md Select Key Key Y 9 Key
00000 B Reading
Serial Setup 3 Data sent in continuous Peak
(continued) mode Valley
Reading + peak
Reading + valley
Reading + peak + valley
SEr 4 | 000 B 1sec
Serial Setup 4 Modbus* ASCII gap timeout 3 sec
5 sec
10 sec
000 @ Custom ASCII*
Serial protocol Modbus* RTU
Modbus* ASCII
| 000 @ None
Parity Odd
Even
__ 000 000 000 158
Modbus Address Select digit to flash. Select [§ through [§ for flashing digit.

Address range is 1 to 247.

* See Glossary for explanation of item.
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| 18. PARALLEL BCD OUTPUT OPTION I

An optional parallel BCD output board may be connected to the meter main board at plug
position P13 (middle position). Once installed, the board is recognized by the meter, which
will bring up the appropriate menu items. The BCD board provides isolated, buffered,
stored, 3-state parallel outputs that are jumper selectable for either 0-5V logic (LSTTL,
CMOS compatible) or 0-15V dc. BCD outputs are positive true. Polarity bit is positive true

for +sign.
Logic Level Jumper
0to 5 Vdc b
0 to 15 Vdc a

BCD CONTROL SIGNALS

Enable Logic 0 - All outputs go to high impe-
dance state.
Logic 1 - BCD information is available
at outputs.

/ BCD Hold  Logic 0 - BCD from last update prior to

BCD Hold going low is stored.
Logic 1 - BCD information is updated

at selected rate.

BCDOUTPUT
1 |4 2
4 |3 4
10 |5 6
40 |7 8
100 |9 10
400 |11 12
1K |13 14
4 |15 16
10K |17 18
40K |19 20
100K |21 22
400K |23 24
+POL |25 26
BCOHOLD |27 28
ISOLATEDGND |29 30

/ Data Ready Logic 0 - BCD outputs are valid.
Logic 1 - BCD outputs are not valid.

KEYSTROKES FOR SETUP
If the MENU B key does not work, see Section 9 “Enabling & Locking Out Menu ltems.”

2
8

20

80

200

800

2K

8K

20K

80K

200K

800K
DATAREADY
BCD ENABLE
ISO 5/ 15VDC

Press Menu
amd Select Key

Press lm yntil
SEr 1 is displayed.

H Press Digit Press Value Select

Select Key A Key

| 00 @ Send unfiltered signal

Output filtering Send filtered signal

| 0 0 60 Hz 50 Hz

Output update rate @ Line frequency
0.28 sec 0.34 sec
0.57 sec 0.68 sec
1.1 sec 1.4 sec
2.3 sec 2.7 sec
4.5 sec 5.4 sec
B 9.1sec 10.9 sec
18.1 sec 21.8 sec
B 36.6 sec 43.5 sec
8 72.5sec 97 sec
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| 19. EXCITATION OUTPUTS & POWER SUPPLY I

Three isolated transducer excitation output levels are available from the power supply board.
These are selectable via jumpers b, c, d, e, f in the upper right of the board, as illustrated.
In addition, the board provides three jumper positions for special features. The same jumper
locations apply to the universal power supply (95-240 Vac +10% and 95-300 Vdc £10%) and
to the low voltage power supply (10-34 Vac & 10-48 Vdc).

o000 ooo
bcd ef
a hg
pog 00O
Excitation output Jumper locations
b d e
5 Vdc 5%, 100 mA max b,d, e HE B B R B ERN
0 b d f
10 Vdc £5%, 120 mA max b, d, f EEEE EEBE
24 Vdc 5%, 50 mA max o c
HE BB RN BEERBN

SELECTION OF OTHER JUMPERS

Jumper a - Front panel menu lockout, locked when installed. See Section 9)
Jumper g - Provides +5V power output at P1-4 when installed.
Jumper h - Connects "Control Input 2" to P1-4 when installed.
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20. INSTRUMENT SETUP VIA PC

Instrument Setup software is a PC program which is much easier to learn than front panel
programming. It is of benefit whether or not the meter is connected to a PC. With the meter
connected to a PC, it allows uploading, editing and downloading of setup data, execution of
commands under computer control, listing, plotting and graphing of data, and computer
prompted calibration. With the meter unconnected to a PC, it provides quick selection of
jumper locations and a printable display of menu selections for front panel setup.

SOFTWARE INSTALLATION

Download 1S2*.exe onto your PC from the web or the distribution CD. Double-click on the
downloaded file to unzip it into a special directory, such as c:\temp. Within that directory,
double-click on setup.exe, which will install the software on your PC.

PREREQUISITES FOR CONNECTED USE

1) PC with available RS232 com port.
2) Meter to be set up.

3) RS232 board in the meter. This board can be ]
used for meter setup, then be removed. s 2 A
4) RJ11-to-DB9 RS232 cable to connect the meter G

and PC (see Section 1, Ordering Guide).

RJ11-to-DBS RS-232 cable
5) Instrument Setup software.

ESTABLISHING COMMUNICATIONS

Connect the meter and PC. Apply power to the meter. Be sure that the meter is in Run
Mode, not Setup Mode. To start the software from Windows, click on Start => Programs =>
IS2 => IS2. Click on RS232 => Establish. The program will temporarily set the selected Com
port to the required baud rate, parity, data bits and stop bit. Once communications have
been established, click on Main Menu. The software will sense the type of meter and
installed boards, but it cannot sense jumpers positions nor set jumpers for you. If the
computer is not connected to a meter, select DPM and Series 2.

[ roanien commumesnmnaprey ST Aol

Com Forts Baud Hate Frotocol Select Instrument and Serics

® Com 1 300 & Custom ASCTT
© Com 2 600 " Madbus HTU
' Com 3 C 1200 C Madbus ASCIT

Fanel Meter Transmitter

C oom? ® DFM ClAualog Tnpur
om 2400 .
€ Com5 O 4500 = © Weight Moter
- Parity
© Com 6 ® 9600 - € Counter/Timer  Counter/Timer
C Com 7 19200 Hone Hack
C Com8

O Com 9 . Series

" Series 1
Other Com Port
[ Series 2

| Wait while pting to establish

Meter Type
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LTI =10

=0 x|

Relay Alarms | C icati { Analog Dut T Lockouts

Input+Display Scaling Filter

|npul+DispIayT Scaling T Filter T Relay AIalm:TC icati _“( Analog Out T Lockouts -Alarm 1

rAlarm 2

O BASIC Opti Sig Cond Option Relay Option Comm Option Analog Option Seipoini 1 Seipoint 2
phion
® EXTENDED Bgards “ - ’]Relay Goard v| “REZaZ Board “Nnne | 010000 | [+020000. |

Deviation 1 Deviation 2
r Signal Input “ +000000. ‘ “ -+I00000.
Mode Range Custom Curve Rate 50/60 Hz Line Freq 1S 25
| Alarm. OULTE Alarm OUrce
“DE v =l ’] 0.2 =l ’]Disahled ]“Disahled =l ’V|5n Hz j‘ “Fﬂm " J—‘ “Fﬂw a JT
e aa:d
rDisplay Alarm 1 State Alarm 2 State
i Display Filter “ High Active j—‘ “ High Active '

Resolution Decimal Point Peak Button Action -Auto Tare
’]4. 5 Digits j ’]Filtered J ’Vddddd J—‘ ’VFeak J‘H’lmsabled j ’71?_,133.1 Alrm State

Relay2 Alrm State
[Actveon =] [ [aciveon =]
Deviation 1 Type Deviation 2 Type
“ Band Deviat'n 7 | [ | Band Deviar'n ¥
r Control Inputs Alarm 1 Type Alarm2 Type
Control Inpuk A —----——---—- Control Input B —-----——------— Both Ctel A, B
’VIMeter Reset Meter Hold Cold Reset j “ Nnn—Lam]dng] “ Nnn—l..au:lu'ngj
Alarms 1.2 No.Rigs to Alarm
{ 1 Reading T [~ Mo Deviation in Memu
Main Menu | Main Menu

SETUP OF CONNECTED METER

A setup file can be retrieved from the meter (DPM => Get Setup), be edited (View =>
Setup), be saved to disk (File => Save Setup), be retrieved from disk (File => Open Setup),
and be downloaded into one or multiple meters (DPM => Put Setup). Downloading of setup
files from a PC can be a major time saving when multiple meters have to be set up in the
same way.

You will find that Instrument Setup software is very user friendly, with separate tab-
selectable windows for Input+Display, Scaling, Filter, Relay Alarms, Communications,
Analog Out, and Lockouts. If the required hardware, such as the analog output board, is not
sensed, the corresponding tab will be grayed out.

ADDITIONAL FEATURES

e The Commands pull-down menu allows you to execute certain meter functions by using
your computer mouse. You can reset individual meter functions, display current or peak
readings, and enter numbers to be displayed remotely by the DPM. The first position of a
transmitted number must be a blank, + sign or - sign. Five digits and a decimal point must
be transmitted. Leading 0’s serve as blanks. The Commands pull-down menu will be grayed
out unless a Get Setup has been executed.

2900. L | e —————--—""——————
2875,

LT B R e T T
2850.
2825, FI I D | D
2800,

B12 J-mmmmeee oo R - B - oo
2775,
2750

17 ———— 1 1 ] 111 1T
2725,
2700 1]

] _ _ i : _ _ _ i 2725. 2750. 2775. 2800. 2825. 2850. 2875.
Print Save Pause | Continue | New Scale End Print Save | Pause | Continue | New Scale End
Plot Graph
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e The Readings pull-down menu provides three formats to display DPM data on the PC
monitor. Use the Pause and Continue buttons to control the timing of data collection, then
press Print for a hardcopy using your PC printer.

- List presents the latest readings in a 20-row by 10-column table. Press Pause at any
time to freeze the display. Press Print for a hardcopy. List can capture peak readings.

- Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC
combination into a printing digital oscilloscope.

- Graph generates a histogram, where the horizontal axis is the reading and the vertical
axis is the number of occurrences of readings. The display continually resizes itself as
the number of readings increases.

e The Jumpers pull-down menu provides mrErT=r ol

jumper positions for the various meter boards, Sl—_I;:jRa“ge =
duplicating information in this manual. —

IW Ready. gl
e The Calibration pull-down menu allows s P

easy calibration of voltage and current ranges Calib | Desired | Currart Gt | e | e p—
for the DC, load cell, and AC RMS signal [ovbel o 00003 FFFa_| FFDG_| 0003 :;Il
conditioner boards. The PC first recognizes oo Fres | Fres | onon 3
the type of board, then prompts you to apply 5 |
specific jumpers and calibration signals. Press =
Ready to take a reading. Press Repeat to take —
more readings. When you have decided on =B
which reading to accept, press on the number _son |
1 through 10 of that reading. Additional cali-
bration software is available online. MENUKEY |S |1 |2 |3 |4 |5
InPut d C W
METER SETUP WITH AN UNCONNECTED PC SEtuP 0 0 0O O O
Instrument Setup software is also of benefit when the |LGRFG o0 /000
PC is not connected to a meter. Upon launching the |FLEr 010/1]1]6
software, click on None for Communications, then on |-22cPt djdjd.d|d
DPM and Series 2. Click on File => Default Setup to SCALE g /o010
retrieve a default setup file from disk, or on File => Open OFFSt o000 0
Setup to retrieve a previously saved setup file from disk. :E:; 0 g ? ':
To enter new setup information, click on View => Setup, [Lee1 0 0 0 0 0
then make your screen selections as if you were | Loc2 0 0 1 0
connected to a meter. Tabs will be grayed out if you | Loc3 0D 0 0D D
have not selected the required hardware under the
Input+Display tab. When done, press on Main Menu,
then on View => Menu. The selections made under

Setup will now be shown in the form of the required front
panel programming sequence, where each row corresponds to a menu item selected by the
k=) key, and the seven data columns correspond to values entered via the » and A keys.

Click on any step in the sequence to bring up a detailed help window.

Click on Print for a hardcopy, which you can then use as an instruction sheet to program
your meter via its front panel.

Click on Main Menu => File => Save Setup As to save your setup to disk and have an
electronic record.
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21. CUSTOM CURVE LINEARIZATION

Curve.exe is a DOS-based, executable PC program used to set up an Extended meter* so that
the readings have a user-defined, non-linear relationship with the input signal. The calculated
linearizing parameters are downloaded into non-volatile memory of the meter. For example, it
allows a meter to correct for transducer nonlinearity or to display volume of an irregularly
shaped tank based on liquid level. The curve-

fitting algorithm uses quadratic segments of Tank Volume from Pressure
varying length and curvature, and provides at the Bottom of the Tank

diagnostics to estimate curve fitting errors.
The program is self-prompting, avoiding the
need for a detailed printed manual. This
manual section is only intended as an intro-
duction and get-started guide.

PREREQUISITES

1)
2)
3)

4)

5)

PC-compatible computer with an available Com 1 or Com 2 RS232 port.
Extended meter®.
An RS232 board in the meter. This board can be

used for meter setup only, then be removed. = ;
An RJ11-to-DB9 RS232 cable to connect the s o UDGDU Duﬂ
meter and PC (see Section 1, Ordering Guide). &

Curve.exe software (downloadable from the web

at no charge). RJ11-t0-DE9 R5-232 cable

GETTING STARTED

Download curve.exe into the same directory that will contain your data files, such as
c:\curves. Set the meter baud rate to 9600. To do so, press the I key to get to =g, then
set the entry to [lfSEJ. Set the meter address to 1. To do so, press the I key to get to
B, then set the entry to [eFEl. To execute the program from Windows, simply double-click
on curve.exe, which is an executable file. Follow the steps on computer screens, which will
prompt you and provide extensive information. Pressing R (Enter) returns to the main menu.

You will be given the choice to enter your data in one of four modes:

1)

2)

3)

Text file entry mode, with an X value in one column and a Y value in another. There
can be additional columns, which are ignored. The file must have a DOS name of up to
8 characters and the extension .RAW. There can be from 5 to 180 rows. X is the input
value and should be in the unit of measure for which the meter was set up, such as mV,
V, mA or A. Y is the desired corresponding reading and can range from
-99999 to 99999 with any decimal point.

2-coordinate keyboard entry mode, where an actual X input signal is applied, and the
desired Y reading is entered from the keyboard.

2-coordinate file entry mode, where an actual X input signal is applied, and the
desired Y reading is provided from a file.
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4) Equation entry mode, where the coefficients of a polynomial Y = K1X*P1 + K2X*P2 +
K3*XAP3 + ... are entered. Up to 20 terms are allowed. An offset can be built into X.

You will be asked if your DPM has a revision of DPM4L or later. You will normally select 2
(yes), since revision DPMA4L started to ship in August 2000.

You will be asked to supply the following:

LOW X-COORDINATE VALUE >
LOW INPUT MEASUREMENT VALUE >
HIGH X-COORDINATE VALUE >
HIGH INPUT MEASUREMENT VALUE >

This informs the computer of your signal conditioner jumper settings. Enter 0 and O for
the two LOW values. For HIGH X, enter your signal conditioner jumper range in the
same units of measure that you will be using in your *.RAW data input file. Enter 20 for
20 mV or 20V. Enter 200 for 200 mV or 200V. Enter 5 for 5A AC or DC. For HIGH
INPUT MEASUREMENT VALUE, enter 20000, except for 5A DC, where you should
enter 5000.

Position of the decimal point from 6=X.XXXXX, 5= XX. XXX, 4=XXX. XXX, 3=XXXX.XX,
2=XXXXX.X, 1=XXXXXX (for DPMs, the leading X is a blank). Specify the same position
that you specified in the decimal point menu selection.

Follow the steps on the screens to finish generating the custom curve. When prompted to
download the file to the meter, select Y. When prompted to set the meter to custom curve
mode, also select Y.

KEYPAD CONTROL

You can take a meter in and out of custom curve linearization using the meter keypad.
From the Menu mode, press the Imb key to get to [SfJiIR€ then set the fifth digit to either [§
(normal linear operation) or to M (custom curve operation). This fifth digit will only be
displayed with an Extended meter*.

FILES USED OR CREATED BY CURVE.EXE

1) *RAW is the raw input file generated by all four data entry methods.

2) *.DVD adds three columns from which the smoothness of the input data and obvious
input errors can be judged. The more data points and the smoother the data, the better
the curve fit.

3) *.NUM lists Y readings prior to custom curve linearization and addition of the decimal
point.

4) *.CCF is an internal file used by the software.
5) *.SIM lists simulated linearized meter readings and calculated corresponding errors.
6) *.PRM contains the final hex data that is downloaded into the meter.
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| 22. METER CALIBRATION I

All analog input and analog output ranges of the meter have been digitally calibrated at the
factory prior to shipment using calibration equipment certified to NIST standards. Calibration
constants are stored digitally in non-volatile memory in EEPROM on the signal conditioner
board and analog output board. As a result, these boards may be mixed and interchanged
without requiring meter recalibration. Digital calibration eliminates much of circuitry that would
be associated with analog calibration, providing superior long term accuracy and stability.

If recalibration is required, the meter may be returned to the factory or to any authorized
distributor. Easy calibration of DC, AC and load cell signal conditioner ranges is possible using
the Instrument Setup software, as described in Section 20. To allow computer aided calibra-
tion, an RS232 or RS485 interface card must be installed in the meter. This card may be
installed temporarily and be removed following calibration. Step-by-step instructions and
advanced calibration software are available from the factory.

| 23. SPECIFICATIONS |

BASIC METER

Display
TYPE oo, 5 LED, 7-segment, 14.2mm (.56") high digits & 3 LED indicators
C0lOr e Red or green
RANGE.. e i -99999 to +99999 and -99990 to +99990

A to D Conversion

Technique (Pat.5,262,780).......ccoo o Concurrent Slope™
Read Rate ........coovveiiiiieeeeeeeeeeeeee e, 60/s for 60 Hz NMR, 50/s for 50 Hz NMR
Output Update Rate ..........oooemiiiiiiei e 56/s at 60 Hz, 47/s at 50 Hz
Display Update Rate .........ccoooiiiiiiiiiieee e 3.5/s at 60 Hz, 3/s at 50 Hz

Noise Rejection

CMV from DC 10 60 HzZ.....cooeeeeee e Withstand 250Vac
Dielectric strength..........cccooooiiiiiii 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
CMRrom DCtO B0 HZ ... 130 dB
NMR at 50/60 Hz........oovveieieieeeeee e 90 dB with minimum digital filtering

Control Inputs (CMOS/TTL levels, logic 1 = tied to digital ground, logic 0 = open)

FTHOIA INPUL ... Logic 1 holds display and outputs

[T PEAK INPUL ...t Logic 1 displays peak value

1= 1= o1 | Logic 1 offsets input value to zero

T RESEtINPUL ... e Logic 1 resets all meter functions

/ Function Reset input ..., Logic 1 resets peak values and alarms

/ Decimal Point input ..................... Overrides internal DP selections and controls DP position
ACCURACY
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DC Volts RTD (0.01°, 0.1°, 1° resolution)

Voltage , Input Error at Pt 100 o
Range Resolution Ohms e Type Range Error at 25°C
200.00 mV | 10 pV 1GQ DIN -202 to 850°C [.01% FS +0.03°C
2.0000 V 100 pVv 1GQ 0.01% .00385 | -331to 1562°F | .01% FS +0.05°F

20.000 V 1 mV 1 MQ of FS S

200.00V | 10mV | 1MQ | £2Cts ANS| | -20210631°C |.01% FS £0.04°C

3000V | 100mv | 1 MO .003925 | -331 10 1168°F | 01% FS +0.07°F
DC Amps Thermocouple (0.1°, 1° resolution)

Current . Input Error at TC o
Range Resolution Ohms 05°C Type Range Error at 25°C
2.0000mA | 0.1 pA 100 Q 0.01% J -210to 760°C [.01% FS +0.09°C
20.000 mA 1 uA 10 Q P -347to 1400°F [.01% FS +0.16°F

20000mA| 10pA | 10 | OFS
5 (')00 A 1 rr}ij 0010 12 Cts K -244 10 1372°C |.01% FS +0.10°C
: : -408to 2501°F [.01% FS +0.17°F
Ratio 0t0400°C |.01% FS £0.03°C
T -257 to 0°C  |.01% FS 1£0.20°C
Current Resolution Input Error at 3210 752°F |.01% FS +£0.05°F
Range Ohms 25°C -430 to 32°F |.01% FS +0.36°F
200.00 mV |10 pV 1GQ 0.01% E -240 to 1000°C |.01% FS £0.18°C
2.0000V [100 pVv 1GQ of FS -400 to 1830°F | .01% FS +0.32°F
20.000V |1 mV 1 MQ 12 Cts
N -245 to 1300°C [.01% FS +0.10°C
-410 to 2370°F | .01% FS +0.17°F
True RMS Volts (1% to 100% of Full Scale)
S -46 to +68°C |.01% FS +£0.12°C
Voltage | o solution| MPut | Error at -51to +213°F |.01% FS £0.22°F
Range Ohms 25°C
R -45 t0 1768°C [.01% FS +£0.17°C
200.00 mV | 10 pv 22MQ | e, -49 to 3214°F |.01% FS +0.31°F
20000V | 100pV | 22MQ | = FS"
20.000 V 1mV 1 MQ ’
200.00 V 10 mvV 1 MO 1100|—I|<T—Itzo Load Cell Input
Input Reso- Error at
Range lution Zero | Span 25°C
True RMS Amps (1% to 100% of Full Scale) Range| Range
Current | oocoiution| neut | Error at 20.000 mV'| 1 uV .
Range Ohms 25°C 50.000 mV | 2.5 pV [-99999 0to 0.01%
100.00 mV| 5 uVv to +99 999 of FS
2.0000 mA| 0.1 pA 1000 | 0.15% 250.00 mV [12.5 pv|99999  ~~™ +1 Ct
20.000 mA 1 HA 10 Q of FS, 500.00 mV | 25 pV
200.00 mA| 10 pA 10 10 Hz to
5.000A | 0.25mA 0.01Q 10 kHz

49




SPAN TEMPCO ..o 0.003% of reading/°C

0.0015% of reading/°C for load cell meter
W= (o T =Y 1 4] o Yot o J P OOPR PSP 0.2 uv/°C
Reference JuNCLioN ACCUFACY ........uuiiiiiiiiiieiiicee e 1°C, 10°C to 40°C

POWER REQUIREMENTS

Input Voltage rating (standard)............ccooooeeriinninnnnnnnn. 95-240V ac +10% or 90-300V dc +10%
Input Voltage rating (low voltage option) ..........cceevvviiiiiiiiiiiiiiiiiiiinnnnn. 10-34V ac or 10-48V dc
Power LiN€ FrEQUENCY ......covviiiieiiiiee et e e e e DC and 47-63 Hz
Power Consumplion, MaX ........coouuiiiiiii e 5 Watts

EXCITATION OUTPUTS

Voltage & Current Levels (jumper selectable) ...............uvvveveeenennnee. 5V dc £5%, 100 mA max
10V dc £5%, 120 mA max
24V dc + 5%, 40 mA max

Excitation OUtpUt RIPPIE.....ccoe e 100 mVp max
Isolation from power and OULPULS ..........coeiiiiiiiiiiiceee e 250 Vac
Insulation dielectric strength to power and outputs..... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Isolation to signal COMMION .........ooouii e 50V dc

DUAL RELAY OPTION

Power to Relay Option ............uuiiiiiiiiiiiiiiiiiiiiiiiiieeee e Powered by meter
Setpoint Setup.....ovvviiiiiii Via front panel pushbuttons or RS232/485
Update Rate ........cooooiiiiee e 56/s at 60 Hz, 47/s at 50 Hz
Response to input signal (Min)........cccoooeiiiiiiii e, Display update rate
Input Signal (selectable)...........cooovviiiiiiiiiiiiiiiiiiiiie Filtered or unfiltered input signal
Actuation Modes (selectable)...... Above or below setpoint, latching or non-latching, disabled
Output Time Delay (selectable) ... 1 to 128 readings
Front Panel Enable / Lockout Modes (selectable)................ 1) Display and change setpoints

2) Display but do not change setpoints
3) Neither display nor change setpoints

Alarm Status INAICatioN ..........coooiiii s 2 red LED lamps
Status Indication Setup (selectable)....................... Lit when output is ON or OFF, or disabled
Contact Relay Output:

AC RAING et 8A @ 240V ac
DC RAEING ...ttt 8A @ 24V dc
Isolation rating between signal common and contacts ..............ccceeiriiiiiiiiiciin e, 250V ac
Insulation dielectric strength between signal common and contacts ................cceevviviiiiiiiieenenee.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
Solid State Relay Output:

AC RatinNg.....vvveieeeeiieieeeeee e 120 mA @ 125V ac, 24 ohms series resistance
DC Rating......uuuuumiiiiiiii 240 mA @ 150V dc, 6 ohms series resistance
Isolation rating between signal common and contacts ..............cceeieiiiiiiiieiiie e, 250V ac
Insulation dielectric strength between signal common and contacts ................cceevvvviiiieiiieenene.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
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ANALOG OUTPUT OPTION

Power to Analog Output Option..........ccoooiiiiiiiiii e, Powered by meter
Output Levels (voltage & current available simultaneously) ... 0-20 mA or 4-20 mA and 0-10V
Voltage Compliance, 0-20 mA Output...........oooimiiiiiiiiiiiiieeee 12V (0-600 Ohm load)
Current Compliance, 0-10V Output ...........cooiveiiiiiiiiieeeeeee 2 mA (5 kOhm or higher load)
ACCUIACY ...evviiiiieeiiieeeiiiieie e Meter input accuracy £0.1% of full scale analog output
RESPONSE TIME ... e e e e Display update rate
Scaling of Reading for Zero Output..........cccoooiiiiiiiiiiici e, -99,999 to +99,999
Scaling of Reading for Full Scale Output.............cooviiiiiiiii e -99,999 to +99,999
Isolation rating between signal common and analog output...............cooiiiiiiiiiiineene, 250V ac
Insulation dielectric strength between signal common and analog output............ccccceeiineo.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

SERIAL INTERFACE OPTION (RS232, RS485, RS485-Modbus boards)

Power to Interface OptioN.............uuueueeiiiiiiiiiiiiiii s Powered by meter
RS485 WIFING ...ttt e e e e e e Half or full duplex
Baud Rates ............evvviiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeeee 300, 600, 1200, 2400, 4800, 9600, 19200
Serial Protocols ............ccccceeen. Custom ASCII*, Modbus* RTU, Modbus™* ASCII (selectable)
Signal Levels ... Meet RS232 and RS485 standards
Connectors................. Single RJ11 (RS232), two RJ11 (RS485), two RJ45 (RS485-Modbus)
Isolation rating between signal common and serial 1/O ............ccccooviiiiiiiiiiiiiiie e 250V ac
Insulation dielectric strength between signal common and serial /O ...
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min

PARALLEL BCD OUTPUT OPTION

Power to BCD Output Option ...........ciiiiiiiiiccee e Powered by meter
157/ 1 3-state, stored, parallel
SIGNAI LEVEIS ...t LSTTL, CMOS compatible
(070 ] )1 o] £ BCD Enable, Hold, Data Ready
Isolation rating between signal common and BCD output..........cccceooeiiiiiiiiiiieennnee, 250V ac
Insulation dielectric strength between signal common and BCD output.............coooiiiiieeon.
................................................................................... 3.5 kV ac for 5 sec, 2.3 kV ac for 1 min
ENVIRONMENTAL
Operating TempPerature .......... .o e e e 0°C to 55°C
Storage TeMPEratUre .........ooovviiiii e e e e e e e e eeeeaes -40°C to 85°C
Relative HUMIity ............euiiiiiiiiiiiiiiiiiie 95% from 0°C to 40°C, non-condensing
CASE ..t NEMA-4X from front when panel mounted
SNOCK .. 10 G at 1 kHz, applied in X, Y, Z axes
Vibration ........oooveiiiiiiiiie, 15 Hz to 150 Hz, 1 mm to 2 mm amplitude, 20 G max.
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| 24. GLOSSARY OF TERMS |

Adaptive Filter Threshold

A threshold which causes an adaptive moving average filter to be reset to the
latest reading when the accumulated difference between individual readings
and the filtered reading exceeds that threshold. Adaptive moving average
filtering allows a meter to respond rapidly to actual changes in signal while
filtering out normal noise. The accumulated difference is also reset to zero
when the latest reading has a different polarity than the filtered reading. A low
adaptive filter threshold is normally selected. A high filter threshold should be
selected if the signal has large transients.

Alarm, Latched p—
An alarm which stays actuated until reset. Setpoint + ON ™
- 1000| =EtPOINt - *
Latched alarms can shut down machinery or
a process when an operating limit has been hY
exceeded, or maintain an alarm condition K
until acknowledged by an operator.

OFF ON ™

er Reading

Alarm, Non-latched
An alarm which changes state automatically T
when the reading rises above a specified limit Setpoint .~ ON
and changes back automatically when the
reading falls below a limit.

Autofilter A selectable digital filter mode which auto- OFF OFF

matically selects an appropriate moving aver-
age filter time constant from 0.08 sec to 9.6
sec for the encountered noise condition.

Meter Reading §

NON-LATCHED ALARM

Time

Auto-tare A selectable meter operating mode, where
the first reading following power-on or meter reset is used to zero the display.
Further readings are then relative to this new zero.

Batch Average Filter
A digital filter mode which averages 16 readings and then displays the average.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.

Counts The reading displayed on the panel meter ignoring the decimal point.

Custom ASCII Protocol
A simplified, short protocol for use with these panel meters. It allows 31 digital
addresses. Not an industry-standard protocol, like the more complex Modbus
protocol, which is also offered with the meters.

Deviation Band
A band in counts which controls relay action symmetrically around a setpoint.
The relay actuates when the reading falls within the deviation band, and de-
actuates when the reading falls outside. A limit (e.g., 50 counts) is set up
around both sides of the setpoint to create a deviation band (e.g., 100 counts).
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Display Blank A rear panel input which blanks the display

Setting up a passband around a setpoint is
often used for component testing. Deviation .

limits are programmed by entering menu item |, 50| 72! Lt .,

dEU1b for Alarm 1 and dEU2b for Alarm 2. |;45]725® ¢ o, *

[ ]
The deviation band will be equal to two limits. | gsg| P35S, *, > Sefpoint 9% %

Fail. *

s Setpoint = 1000
Deviation limit = 50
Deviation band = 100

Reading

when the input is tied to logic ground by a
switch or OV is applied (logic level true). The
meter display will light when the input is Parts
open or is held at +5V (logic level false).

Extended Meter

Full Scale

A digital panel meter with an enhanced microcomputer that provides added
capabilities, specifically linearization of nonlinear inputs and display of rate of
change from successive readings.

The maximum input signal range for which the meter has been configured. For
example, the most sensitive full scale for the load cell meter is £20 mV (signal
range from -20 mV to +20 mV).

Function Reset

Ground Loop

Jumper

Hysteresis Band

A rear panel control input which resets Peak, Valley and any latched alarms
when the input is tied to logic ground by a switch or OV is applied (logic level
true). To reset the value again, the input must be open or 5V applied (logic
level false) and then set low.

A closed conductive path in external ground wiring that allows stray currents to
flow in ground wiring, creating ground noise. The meters in this manual
minimize ground loop problems by mutually isolating the grounds associated
with meter power, signal input, and all output and communication options.

A push-on component which provides a short between two adjacent posts on a
circuit board. Jumpers are used to configure signal conditioner boards for
specific signal types and full scale ranges, and to configure power supply and
communications boards for various modes of operation. Unused jumpers are
stored by pushing one side over an unused post.

A band which controls relay action sym- Heater Heater Heater
metrically around a setpoint. The relay . OFF . OFF A OFF
closes (or opens) when the reading goes ' /
above the setpoint plus one hysteresis limit,
and opens (or closes) when the reading
falls below the setpoint less one hysteresis
limit. A narrow hysteresis band is often
used to minimize relay chatter around a
setpoint due to electrical noise or signal
feedback caused by load switching. A wide
hysteresis band can be used for control applications, such as turning on a fill
pump when the tank level has reached a lower limit and shutting off the pump

1050

1000 H%arfjer \\ H;)é:jer \H(‘Ciiél\tler\\

L

Setpoint = 1000
Hysteresis limit = 50
Hysteresis band = 100

Reading §

Time
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Menu Mode

Meter Hold

Modbus

when the tank level has reached an upper limit. The hysteresis band will be
equal to two hysteresis limits.

The meter programming mode used for input and range selection, meter setup,
and meter configuration. Entered into from the Run mode by pressing the
MENU key. The Menu mode can be locked out completely by a jumper.

A rear panel input which freezes the meter display and all meter outputs while
that input is tied to logic ground by a switch or is held at OV (logic level true).
The meter will resume operation when the input is allowed to float or is held at
+5V (logic level false).

An industry-standard serial communications protocol which allows devices by
different manufacturers to be digitally addressed by a PC on the same com-
munication line, with up to 247 digital addresses. More complex than the
Custom ASCII protocol, which is also supported by these meters.

Moving Average Filter

Offset

Peak Display

A digital filter mode which displays a weighting moving average of readings.
Readings are taken at 60/sec with 60 Hz power and 50/sec with 50 Hz power.
Display update rates remain 3.5/sec with 60 Hz power and 3.0/sec with 50 Hz
power. There are eight moving average modes:

Old average x 1/2 + new reading x 1/2 (equivalent to 0.08 sec RC time constant).
Old average x 3/4 + new reading x 1/4 (equivalent to 0.15 sec RC time constant).
Old average x 7/8 + new reading x 1/8 (equivalent to 0.3 sec RC time constant).
Old average x 15/16 + new reading x 1/16 (equivalent to 0.6 sec RC time constant).
Old average x 31/32 + new reading x 1/32 (equivalent to 1.2 sec RC time constant).
Old average x 63/64 + new reading x 1/64 (equivalent to 2.4 sec RC time constant).
Old avg. x 127/128 + new reading x 1/128 (equivalent to 4.8 sec RC time constant).
Old avg. x 255/256 + new reading x 1/256 (equivalent to 9.6 sec RC time constant).

A constant adder used for the displayed reading. This is the term b in the
straight line formula y = mx + b, where y is the displayed reading in counts, m
is the scale factor, x is the measured reading in counts, and b is the offset. For
direct readout in (milli)volts or (milli)amps, offset is 0.

The maximum (or most positive) reading since that maximum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Process Signal

A signal whose display requires setup of scale and offset settings for display in
engineering units. A classical process signal is 4-20 mA, where the 4 mA and
20 mA end points can each correspond to a desired meter reading.

Rate of Change Meter

A configuration mode of the Extended meter which allows the display of rate
based on successive readings. The conversion to engineering units is achieved
with the combination of a multiplier from 0.1 to 10,000 and a scale factor.
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Reading

The value displayed by the meter. “Taking a reading” is the action of the meter
to make an analog-to-digital conversion. Readings are taken at 60/sec with 60
Hz power or 50/sec with 50 Hz power, and are displayed with an update rate of
3.5/sec with 60 Hz power or 3.0/sec with 50 Hz power.

Remote Display

Reset

A display mode which allows the meter to serve as a remote display to another
meter when connected to it by a 4-wire phone cord. Also allows the meter to
transmit raw measurement data to a computer and then display processed data
from the computer. A serial communications option board is required in the
meter. If such a board is not installed or no serial data is received, the meter
displays rESEt.

There are three types of Reset:

= Peak and Valley Reset. Achieved by simultaneously pressing the RESET
and PEAK keys.

» Latched Alarm Reset. Achieved by simultaneously pressing the RESET and
ALARMS keys.

= Meter Reset. Causes the meter to reinitialize and take a tare reading when
set up for auto-tare. Achieved powering up the meter, by pressing the
RESET and MENU keys simultaneously, stepping through all top-level
menu choices, grounding a rear panel connector, or supplying an ASCII
command. rESEt is displayed briefly.

RS485 Half Duplex

Serial communications implemented with two wires, allowing data transmission
in both directions, but not simultaneously.

RS485 Full Duplex

Run Mode

Scale

Scaling

Serial communications implemented with four wires, allowing data transmission
in two directions simultaneously.

The normal operating mode of the meter, where readings are taken, as
opposed to the menu mode.

A constant multiplier used to go from A/D §
converter counts to displayed counts. This is | >g
the slope term m in the straight line formulay |5 £ Py
= mx + b, where y is the displayed reading in § 8 ' High input,
counts, m is the scale factor, x is the |2§ o high reading
measured reading in counts, and b is the &g Low input,
offset. For direct readout in (millivolts or [0 & low reading
(milli)amps, scale is 1. T Offsetb

0
The process of setting scale and offset so 0 Counts x from A/D converter
that the meter reads properly in engineering Full span -32,768 to 32,768

units (such as psi).

Scaling, Coordinates of 2 Points Method

A scaling method where four numbers are entered manually: low input, desired
reading at low input; high input, and desired reading at high input. The meter
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then applies a straight line fit. The decimal point is set by the separate dEC.Pt
menu item.

Scaling, Scale and Offset Mmethod
A scaling method where scale and offset are entered manually.

Scaling, Reading Coordinates of 2 Points Method

A scaling method, where the low and high input values are determined from
actual signals. A known low signal is first applied to the meter, such as the
output of a pressure transducer at zero pressure. That signal is captured as the
low input value, and the desired low reading is entered. A known high signal is
then applied, such the output of a transducer for a know weight or pressure.
That signal is captured as the high input value, and the desired high reading is
entered. The meter then applies straight line fit. This scaling method has the
advantage of calibrating the transducer and meter as a system. The actual
voltage or current at either point does not need to be known. The decimal point
is set by the separate dEC.Pt menu item.

Setpoint A value compared to the reading to determine the state of a relay. Term often
used interchangeably with “alarm setpoint.” The relay action can by latching or
non-latching, utilize a hysteresis band, or utilize a deviation band. Hysteresis
bands and deviation bands are specified by two symmetrical limits around the

setpoint.
Span The number of counts corresponding to a given signal range.
Tare A rear panel input which causes the display to be set to zero when the input is

momentarily tied to logic ground by a switch or is held at OV (logic level true).
When the input is allowed to float or is held at +5V (logic level false), the meter
displays readings relative to this new zero. A common application is in
weighing, where an external Tare button is pressed to read the weight of an
empty scale (tare), and tare is then automatically subtracted as a constant from
gross weight for display of net weight. Tare can also be used for other appli-
cations where a reading relative to starting point is desired.

Valley Display
The minimum (or most negative) reading since that minimum was last reset.
Reset can be via the meter front panel, an external input, or a software
command. The displayed value can reflect the filtered or unfiltered readings.

Zero When used with process meters, zero is an adjustment so that a given low
transducer output reads zero on the meter. Zero is adjusted by programming
offset.
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| 25. WARRANTY |

Laurel Electronics Inc. warrants its products against defects in materials or workmanship for a
period of one year from the date of purchase.

In the event of a defect during the warranty period, the unit should be returned, freight prepaid
(and all duties and taxes) by the Buyer, to the authorized Laurel distributor where the unit was
purchased. The distributor, at its option, will repair or replace the defective unit. The unit will be
returned to the buyer with freight charges prepaid by the distributor.

LIMITATION OF WARRANTY

The foregoing warranty shall not apply to defects resulting from:

Improper or inadequate maintenance by Buyer.

Unauthorized modification or misuse.

Operation outside the environmental specifications of the product.
Mishandling or abuse.
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The warranty set forth above is exclusive and no other warranty, whether written or oral, is
expressed or implied. Laurel specifically disclaims the implied warranties of merchantability
and fitness for a particular purpose.

EXCLUSIVE REMEDIES

The remedies provided herein are Buyer's sole and exclusive remedies. In no event shall
Laurel be liable for direct, indirect, incidental or consequential damages (including loss of
profits) whether based on contract, tort, or any other legal theory.

Copyright 1993-2006 Laurel Electronics, Inc. REV-1A 12/06

- 57--





